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Thank you for purchasing a FMA-1600A Series Gas Flow Meter. 

Please take the time to find and read the information contained in this manual. 
This will help to ensure that you get the best possible service from your 
instrument. This manual covers the following Omega instruments:

 FMA-1600A Series Mass Gas Flow Meters

 FMA-LP1600A Series Low Pressure Drop Mass Gas Flow Meters

 FMA-1600A-LSS Series Mass Gas Flow Meters

FMA-1600A-LSS Series Flow Meters are for use with certain aggressive gases 
(see page 61).

 FMA-1600A-B Series Portable Gas Flow Meters

All FMA-1600A-B Series Portable Gas Flow Meters operate in accordance with 
the instructions found in this manual. Please see page 47 for information 
regarding portable meter operation.

Unless otherwise noted, the instructions in this manual are applicable to all of 
the above instruments.

Full specifications for each device can be found on pages 51 through 65.

Please contact Omega  at 800-826-6342 if you have any questions 
regarding the use or operation of this device.

Many Omega  meters are built for specific applications. Two meters with 
the same flow range and part number may look and act quite differently 
depending upon the application the meter was built for. Care should be 
taken when moving a meter from one application to another.
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GETTING STARTED
8 Pin Mini-DIN

Display Screen

Inlet Connection Port

Flow Direction Arrow

Outlet Connection Port

Power Jack

Medium Mass Flow Meter

MOUNTING
FMA-1600A Gas Flow Meters have holes on the bottom for mounting to flat 
panels. See pages 51-65. 
FMA-1600A Meters can usually be mounted in any position. 
No straight runs of pipe are required upstream or downstream of the meter. 

PLUMBING
Your meter is shipped with plastic plugs fitted in the port openings. To 
lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.

Make sure that the gas will flow in the direction indicated by the flow arrow.
Standard FMA-1600A Gas Flow Meters have female inlet and outlet port 
connections. Welded VCR and other specialty fittings may have male ports.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 51-65.
Meters with M5 (10-32) ports have O-ring face seals and require no sealant or 
tape. Do not use tape with welded or O-ring fittings.
For non M5 (10-32) ports use thread sealing PTFE tape to prevent leakage 
around the port threads. 
Do not wrap the first two threads. This will minimize the possibility of getting 
tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the meter should they get 
into the flow stream.
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We recommend the use of in-line sintered filters to prevent large 
particulates from entering the measurement head of the instrument. 
Suggested maximum particulate sizes are as follows:
5 microns for units with FS flow ranges of 0-1 sccm or less.
20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

PRESSURE
Maximum operating line pressure for FMA-1600A units is 145 psig (1 MPa). 
If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator 
upstream from the flow meter to reduce the pressure to 145 psig (1 MPa) or less.
Maximum operating line pressure for FMA-LP1600A units is 50 psig.

Exceeding the maximum specified line pressure may cause permanent 
damage to the solid-state differential pressure sensor.

Do Not subject an FMA-1600A Differential Pressure sensor to 
upstream-downstream pressure differentials exceeding 75 PSID.
Do Not subject a FMA-LP1600A Differential Pressure sensor to 
upstream-downstream pressure differentials exceeding 15 PSID. 

While high static pressure will typically not damage the dp sensor, sudden 
pressure “spikes” can result in complete failure of the sensor. 

A common cause of this problem is instantaneous application of 
high-pressure gas as from a snap acting solenoid valve either upstream 
or downstream of the meter. If you suspect that your pressure sensor is 

damaged please discontinue use of the meter and contact Omega.
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your meter through either the power jack or the 8 pin 
Mini-DIN connector. 

An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 

Meters require a 7-30 Vdc power supply with a 2.1 mm female positive center 
plug capable of supplying at least 100mA. 

Note: 4-20mA analog output requires at least 15 Vdc.

Standard 8 Pin Mini-DIN Pin-Out

Pin Function Mini-DIN 
cable color

1 Not Connected (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS232RX / RS485(–) Input Signal (receive) Red

4 Meters = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS232TX  / RS485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini-DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.



 







CAUTION! Do not connect power to pins 1 through 6 as permanent 
damage can occur!

It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc 
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects 
the system bus voltage and can be used as a source for the set-point signal.

For DB15 Pin-outs, see pages 67 to 73. 

1 2

3 4 5

6 7 8
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INPUT SIGNALS
Analog Input Signal

Apply analog input to Pin 4 as shown on page 8.

For DB15 Pin-outs, see pages 67 to 73. 

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 4, with common ground on pin 8. 

Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be 
applied to pin 4, with common ground on pin 8.

Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be 
applied to pin 4, with common ground on pin 8. 

NOTE: This is a current sinking device. The receiving circuit is essentially a 
250 ohm resistor to ground.  

NOTE: 4-20 mA output requires at least 15 Vdc power input.

A remote tare can be achieved by momentarily grounding pin 4 to tare 
as shown above.

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

4

8
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RS232 / RS485 Digital Input Signal

To use the RS232 or RS485 input signal, connect the RS232 / RS485 Output 
Signal (Pin 5), the RS232 / RS485 Input Signal (Pin 3), and Ground (Pin 8) to your 
computer serial port as shown below. (See page 26 for details on accessing 
RS232 / RS485 input.)













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port


 









 











1

8 7 6

5

4

3

2

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector

9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5

DB9 to Mini-DIN Connection for RS232 / RS485 Signals
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OUTPUT SIGNALS

RS232 / RS485 Digital Output Signal

To use the RS232 or RS485 output signal, it is necessary to connect the RS232 / 
RS485 Output Signal (Pin 5), the RS232 / RS485 Input Signal (Pin 3), and Ground 
(Pin 8) to your computer serial port as shown on page 8. (See page 26 for 
details on accessing RS232 / RS485 output.)

Standard Voltage (0-5 Vdc) Output Signal

FMA-1600A flow meters equipped with a 0-5 Vdc (optional 0-10 Vdc) will 
have this output signal available on Pin 6. This output is generally available in 
addition to other optionally ordered outputs. This voltage is usually in the range 
of 0.010 Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is 
linear over the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your meter was ordered with a 0-10 Vdc output signal, it will be available on 
Pin 6. (See the Calibration Data Sheet that shipped with your meter to determine 
which output signals were ordered.) This voltage is usually in the range of 0.010 
Vdc for zero flow and 10.0 Vdc for full-scale flow. The output voltage is linear over 
the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your meter was ordered with a 4-20 mA current output signal, it will be 
available on Pin 1. (See the Calibration Data Sheet that shipped with your meter 
to determine which output signals were ordered.) The current signal is 4 mA at 
0 flow and 20 mA at the meter’s full scale flow. The output current is linear over 
the entire range. Ground for this signal is common on Pin 8. (Current output 
units require 15-30Vdc power.)

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See 
the Calibration Data Sheet that shipped with your meter to determine which 
output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or 
4-20 mA analog signal that can represent any measured parameter. With this 
optional output, a meter could output the mass flow rate (0-5 Vdc on pin 6) and 
the absolute pressure (0-5 Vdc on pin 2). 

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.
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Typical Multiple Device (Addressable) Wiring Configuration

The easiest way to connect multiple devices is with a Multi-Drop Box 
(see page 49).

CAUTION!  Do not connect this device to “loop powered’” 
systems, as this will destroy portions of the circuitry and void 
the warranty. If you must interface with existing loop powered 
systems, always use a signal isolator and a separate power supply.

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2 1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow
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Information for Omega TFT (Color Display) Instruments
Omega TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Omega standard operating instructions 
for our monochrome menus and displays with the following differences.

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 0 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Omega name will turn the device display on or 
off. This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Omega TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in 
the Technical Data page for standard Omega instruments. All standard device 
features and functions are available and operate in accordance with the Omega 
operating manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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PEAK
+0.0

MENU/
MAIN

SCCM
+0.0

TOTAL/ 
TIMER

Totalizer (option only)

BACK RESET

#C
+21.50

+0.000
     CCM

MENU/
TOTAL 

TARE V PSIA
+13.60

+0.000
   SCCM

SCCM
Air+0.00

The Main display shows pressure, 
temperature, volumetric flow and mass 
flow.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your meter was ordered with the 
Totalizer option (page 46), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS
The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can change 
the selected gas, interact with your 
RS232 / RS485 settings or read 
manufacturer’s data. 
Push MAIN to return to the Main display.

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu

Main

00123.45
Scm3

2:05 h:m:s
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MAIN 
This mode defaults on power up, with 
mass flow as the primary displayed 
parameter. 
The following parameters are displayed in 
the Main mode.

Gas Absolute Pressure: This sensor 
references hard vacuum and reads 
incoming pressure both above and below 
local atmospheric pressure. This parameter 
is moved to the primary display by pushing 
the button above PSIA. 
The engineering unit associated with 
absolute pressure is pounds per square 

inch absolute (psia). This can be converted to gage pressure (psig) by subtracting 
local atmospheric pressure from the absolute pressure reading:

PSIG = PSIA – (Local Atmospheric Pressure)
Note: Portable meters have additional pressure options accessed by pushing 
PSIA and MISC2 (see page 48).

Gas Temperature: FMA-1600A flow meters 
measure the incoming temperature of the 
gas flow. The temperature is displayed 
in degrees Celsius (°C). This parameter is 
moved to the primary display by pushing 
the button above °C. 
Pushing the button again allows you to 
select 0C (Celsius), K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 
To select a temperature scale, use the UP 
and DOWN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and return 

to the MAIN display. The selected temperature scale will be displayed on the screen.

Tare: Pushing the TARE V button tares the flow meter and provides it with a 
reference point for zero flow. This is an important step in obtaining accurate 
measurements. It is best to zero the flow meter each time it is powered up. If 
the flow reading varies significantly from zero after an initial tare, give the unit a 
minute or so to warm up and re-zero it.
If possible, zero the unit near the expected operating pressure by positively blocking 
the flow downstream of the flow meter prior to pushing the TARE button. 

Zeroing the unit while there is any flow will directly affect the accuracy 
by providing a false zero point. If in doubt about whether a zero flow 

condition exists, remove the unit from the line and positively block both ports 

#C
+21.50

+0.000
CCM

MENU/
TOTAL

TARE VPSIA
+13.60

+0.000
SCCM

DOWN

CANCEL SET

MODE

  >#C
    K
    #F
    #R
   

UP

+0.00 SCCM
Air

Mass Flow
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before pressing the TARE button. If the unit reads a significant negative value 
when removed from the line and blocked, it was given a false zero. It is better 
to zero the unit at atmospheric pressure and a confirmed no flow condition 
than to give it a false zero under line pressure.

Volumetric Flow Rate: This parameter is located in the lower left of the display. 
It is moved to the primary display by pushing the button below CCM in this 
example. Your display may show a different unit of measure.
Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a 
standard temperature and pressure (typically 14.696 psia and 25 °C). 
This parameter is located in the lower middle of the display. It can be moved to 
the primary display by pushing the button below SCCM in this example. Your 
display may show a different unit of measure preceded by the letter S.

To get an accurate volumetric or mass flow rate, the gas being measured 
must be selected. See Gas Select, page 18. 

MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message (MOV = mass overrange, 
VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) flashes when a measured parameter exceeds 
the range of the sensor. When any item flashes, neither the flashing 

parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. 

If the unit does not return to normal operation contact Omega.
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RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS232 / RS485 settings or read manufacturer’s data.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communications Select

Main

Manufacturer Data

An explanation for each screen can be found on the following pages.

Gas Select

MODEL
INFO

BACK MAIN

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu

O M E G A  

Ph   800-826-6342

Fax  203-359-7700

DOWN

CANCEL SELECT

PAGE

>Recent
  Standard
  Factory Custom
  Composer User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel

UP
#C

+21.50

+0.000
CCM MAIN

TARE V

SCCM
Air

PSIA
+13.60

+0.000
SCCM

+ 0.00

MISC2

BACK
DEVICE
UNITS MAIN

MISC1
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GAS SELECT
Gas Select allows you to set your 
device to up to 150 standard gases and 
mixes. You can also use Composer to 
program and store up to 20 additional 
gas mixes.

Gas Select is accessed by pressing the 
button below GAS SELECT on the Select 
Menu display. 

To select a gas, use the UP and DOWN 
buttons to position the arrow in front of 
the desired gas category. 
 » Recent: Eight most recent selections
 » Standard: Gases and mixes standard 

on earlier Omega instruments (page 33)
 » Factory Custom: Present only if customer 

requested gases were added at the factory
 » Composer User Mixes: Gas mixes 

programmed by the user (page 19)
 » Bioreactor (page 37)
 » Breathing (page 38)
 » Chromatography (page 40)
 » Fuel (page 39)
 » Laser (page 39)
 » O2 Concentrator (page 40)
 » Pure Corrosive* (page 34)
 » Pure Non-Corrosive (page 33)
 » Refrigerant* (page 35)
 » Stack (page 40)
 » Welding (page 36)

Press PAGE to view a new page in the gas category list.

Press SELECT to view the gases in the selected category. Align the arrow with the 
desired gas. Press SET to record your selection and return to the MAIN display. 
The selected gas will be displayed on the screen.

* Pure Corrosive and Refrigerant gases are only available on FMA-1600A-LSS 
instruments that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 33 -40 for a full list of gases in each category. 

DOWN

CANCEL SET

PAGE

>Recent
  Standard
  Factory Custom
  Composer User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel 

UP

DOWN

CANCEL SET

PAGE

> Fuel
  Laser
  O2 Concentrator
  Pure Corrosive
  Pure Non-Corrosive
  Refrigerant
  Stack
  Welding

UP
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COMPOSER
Composer allows you to program 
and save up to 20 custom gas mixes 
containing 2 to 5 component gases 
found in the gas lists (pages 33-40). The 
minimum resolution is 0.01%.

Composer is accessed by selecting 
Composer User Mixes on the GAS 
SELECT display.

Press SET when the arrow is aligned 
with Add Mix.

Name the mix by pressing the UP and 
DOWN buttons for letters, numerals 
and symbols. 

CHANGE CASE – Toggles the letter 
case. Letters remain in selected case 
until CHANGE CASE is pushed again.

Press SET to save the name.

After naming the mix, press ADD GAS 
and select the gas category and the 
component gas.

Select the digit with arrow and adjust 
the % with the UP and DOWN buttons. 
Press set to save. Add up to 4 more 
gases as needed. The total must equal 
100% or an error message will appear.

GAS OPTNS allows you to adjust the 
percentage of the constituents or 
delete a gas from the mix. Gas mixes 
cannot be adjusted after they have 
been saved.

DOWN

CANCEL SET

>Add Mix: 20 Free
UP

DOWN

BACK/
CANCEL

CHANGE 
CASE SET

NEXT
LETTER

Composer Mix name:

 MyGas
 ------˄

UP

ADD GAS

BACK/
CANCEL

CHANGE 
CASE SET

GAS 
OPTNS

Composer Mix: MyGAS

      0.00% of Total

EDIT 
NAME
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Once the mix has been saved, you 
may press CREATE SIMILAR to 
compose an additional mix based 
on the mix you have just saved. 
This CREATE SIMILAR option is not 
available after leaving this screen.

Press CREATE NEW to add a 
completely new mix.

Press SELECT MIXTURE to bring the 
custom mix onto the MAIN display.

MAIN
SELECT 
MIXTURE

CREATE 
SIMILAR

COMPOSER USER MIX
MyGas

HAS BEEN SAVED

CREATE 
NEW

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Air:

 50.00
 ˄

UP DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Ar Argon:

 30.00
 ˄

UP

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of He Helium:

 20.00
 ˄

UP ADD GAS

CANCEL SAVE

GAS 
OPTNS

Composer Mix: MyGAS
   50% Air
   30% AR Argon
   20% He Helium
 100.00%  Total

EDIT 
NAME
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM or RS485 
COMM on the Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS232 or RS485 
computer port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS232 Communications (page 25) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
6.3% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 31, with zero being the 
lightest and 30 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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DIAG
TEST

BACK MAIN

STP/
NTP

ROTATE 
DISP

STP
PRESS

MAIN

STP
TEMP

STP TEMP Display

CLEAR

DOWN

BACK/
CANCEL

Temperature: #C

SET

UP SELECT
DIGIT

25.0000

MISC2 will display as shown at left. 
STP/NPT refers to the functions that allow 
your selection of standard temperature and 
pressure conditions or normal temperature 
and pressure conditions. This feature is 
generally useful for comparison purposes to 
other devices or systems using different STP 
parameters. 
The STP menu is comprised of the STP TEMP 
and STP PRESS screens. 
STP TEMP allows you to select from 0C, 0F, K 
or 0R. The arrow position will automatically 
default to the currently stored value. 
The NTP menu is comprised of the NTP 
TEMP and NTP PRESS screens. 
Once a selection has been made and recorded 
using the SET button, a change acknowledgement 
message will be displayed on screen. 
Selecting MAIN will revert screen to the 
Main display. If the SET selection is already 
the currently stored value, a message 
indicating that fact will appear. 
STP PRESS enables you to select from a 
menu pressure settings. Use the UP/DOWN 
or PAGE buttons to view the settings.
The arrow position will automatically default 
to the currently stored value. 

Once a selection has been made and recorded using the SET button, a change 
acknowledgement message will be displayed on screen. 
Pressing SET again will revert screen to the Main display. If the SET selection is 
already the currently stored value, a message indicating that fact will appear. 

STP PRESS Display

101355.0

DOWN

BACK/
CANCEL SET

UP SELECT
DIGIT

Pressure: PaA

CLEAR
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BACK MAIN

SCROLL
R8:     AP Sig 7871
R9:     Temp Sig 39071
R10:    DP Side 9986
R11:     DP Brdg 36673
R13:    AP Brdg 36673
R16:    Meter Fun 199
R18:    Power Up 32768

DIAG TEST: This diagnostic screen displays 
the current internal register values, which 
is useful for noting factory settings prior 
to making any changes. It is also helpful 
for troubleshooting with Omega customer 
service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The 
display and buttons will rotate together.

DEVICE UNITS
Press DEVICE UNITS to access menus of 
units of measure for each parameter (and 
totalizer if so equipped).
Scroll to the desired unit and press select.
Once selected, you will see the message 
shown below. Verify that all connected 
devices expect the change.
See pages 41 and 42 for a full list of 
available units.

DOWN

DONE SELECT

Mass Flow
Volumetric Flow
Pressure
Temperature
Mass Totalizer
Totalizer Time

UP

DOWN

CANCEL SET

PAGE

SCCM
Scm3/h
Sm3/h
Sm3/d
Sin3/m
SCFH
NmL/s

UP
PRESSING SET WILL

AFFECT DISPLAY
AND SERIAL VALUES

VERIFY CONNECTED 
SERIAL DEVICES 

EXPECT THE CHANGE

SETCANCEL
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow meter 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN1

BACK MAIN

O M E G A

Ph    800-826-6342

Fax  203-359-7700

MODEL:   FMA-1600A-100SCCM-D
SERIAL NO:  100903
DATE  MFG:     10/7/2014
DATE  CAL:     10/9/2014
CAL  BY:   DL
SW REV:   5v00.G
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RS232 / RS485 Output and Input
Configuring HyperTerminal®:

1. Open your HyperTerminal® RS232 / RS485 terminal program (installed under 
the “Accessories” menu on all Microsoft Windows® operating systems).

2. Select “Properties” from the file menu.
3. Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS232 / RS485 communications menu on the meter) and an 8-N-1-None (8 
Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box and 
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings 
not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.

Streaming Mode (RS485 units do not have a streaming mode)

In the default Polling Mode, the screen should be blank except the blinking cursor. 
In order to get the data streaming to the screen, hit the “Enter” key several times 
to clear any extraneous information. Type “*@=@” followed by “Enter” (or using 
the RS232 / RS485 communication select menu, select @ as identifier and exit 
the screen). If data still does not appear, check all the connections and COM port 
assignments.

Streaming Mode – Advanced 

The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 

If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 

Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 

To read register 91, type “*r91” followed by “Enter”. 

To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 

To return to the recommended factory default streaming speed, type “*w91= 50”.
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Tareing via RS232 / RS485:

Tare –Tareing (or zeroing) the flow meter provides it with a reference point for 
zero flow. This is a simple but important step in obtaining accurate measurements. 
It is good practice to “zero” the flow meter each time it is powered up. A unit may 
be Tared by following the instructions on page 10 or it may be Tared via RS232 / 
RS485 input. 

To send a Tare command via RS232 / RS485, enter the following strings:

In Polling Mode: Address$$V<Enter>        (e.g. B$$V<Enter>)

Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode (RS485 units do not have a streaming 
mode), the screen is updated approximately 10-60 times per second (depending 
on the amount of data on each line) so that the user sees the data essentially in 
real time. It is sometimes desirable, and necessary when using more than one 
unit on a single RS232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data 
when it is “polled”. Each unit can be given its own unique identifier or address. 
Unless otherwise specified each unit is shipped with a default address of capital 
A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1. Type *@=A followed by “Enter” (or using the RS232 / RS485 communication 
select menu, select A as identifier and exit the screen) to stop the streaming 
mode of information. Note that the flow of information will not stop while 
you are typing and you will not be able to read what you have typed. Also, 
the unit does not accept a backspace or delete in the line so it must be typed 
correctly. If in doubt, simply hit enter and start again. If the unit does not 
get exactly what it is expecting, it will ignore it. If the line has been typed 
correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit is 
on the RS232 / RS485 line as all of the addresses will be reassigned. Instead, 
each should be individually attached to the RS232 / RS485 line, given an 
address, and taken off. After each unit has been given a unique address, they 
can all be put back on the same line and polled individually.
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Gas Select – The selected gas can be changed via RS232 / RS485 input. To change 
the selected gas, enter the following commands:

 In Polling Mode: Address$$#<Enter>    (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that this 
also corresponds to the gas select menu on the flow meter screen (the Standard 
gas category is shown in the example below):

# GAS
0 Air Air
1 Argon     Ar
2 Methane    CH4
3 Carbon Monoxide    CO
4 Carbon Dioxide    CO2
5 Ethane    C2H6
6 Hydrogen    H2
7 Helium    He
8 Nitrogen    N2
9 Nitrous Oxide    N2O

10 Neon    Ne
11 Oxygen    O2
12 Propane    C3H8
13 normal-Butane    n-C4H10
14 Acetylene    C2H2
15 Ethylene    C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafluoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium HE-75
26 75% Helium / 25% Argon HE-25

27 90% Helium / 7.5% Argon / 2.5% CO2
(Praxair - Helistar® A1025) A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS) Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter:  $$12<Enter>
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Creating and Deleting Gas Mixtures with Composer using RS232 or RS485
Note: All commands must be prefixed with the unit ID letter. The unit should 
not be in streaming mode.
You may create and store up to 20 gas mixtures containing up to five 
constituent gases each. The constituent gases must be chosen from the existing 
list of gases installed on the device (which may vary model to model). Please 
see pages 33 – 40 for lists of gases and their corresponding gas numbers.
Create a Gas Mixture
To create a gas mixture, enter a single-line command according to the following formula: 
[Unit ID] GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1] 
[Percent 2] [Gas Number 2] …etc. etc.
Notes: Do not type the brackets. There should be only one space between 
all items. Any percentages less than 1, should have a leading zero before 
the decimal (i.e. 0.25 for .25%). Trailing zeros are not necessary but they are 
allowed to help visualize the percentages on screen (as in the example). The 
sum of all percentages must be 100.00 otherwise an error will occur.
Here is an example of a three gas mixture for a new gas called “MyMix1” 
(50% O2, 49.5% Helium, and .5% Neon), stored in user location #236, where the 
unit ID of the device is “A”:

A GM MyMix1 236 50.00 11 49.50 7 0.50 10     <ENTER>
Gas Name: Name your mixture using a maximum of 6 characters.
Gas Mix Number: Composer user mixes have Omega gas numbers between 
236 and 255. You can assign any number in this range to your new mixture. If 
another mixture with the same number exists, it will be overwritten, even if 
that gas is currently selected on the unit. If you enter a 0 here, the new mix 
will be assigned the next available number between 236 and 255.
Percent 1: The percentage of the first constituent gas. The percentage of each 
constituent must be between 0.01 and 99.99. Values entered beyond two 
decimal points will be rounded to the nearest 0.01%.
Gas Number 1: The Omega gas number of the first constituent gas.
Percent 2: The percentage of the second constituent gas. Values entered 
beyond two decimal points will be rounded to the nearest 0.01%.
Gas Number 2: The Omega gas number of the second constituent gas.
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number] 
may be repeated for additional constituent gases (up to a total of five).
Upon success, the unit ID (if set) is returned followed by a space. The number 
of the gas mixture is then returned, followed by the percentages and names 
of each constituent in the mix. If the gas mix is not successfully created, a "?" 
is returned, and you must start over.

Delete a Gas Mixture
To delete a gas mixture, enter: 

[Unit ID]GD [Gas Number]: The number of the Composer user mixture you 
wish to delete from the unit

Only Composer user mixtures can be deleted with this command.
On success, the unit ID (if set) is returned followed by a space and the number of 
the gas deleted. If the gas is not successfully deleted, a "?" is returned.
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Data Format:
The data stream on the screen represents the flow parameters of the main mode 
in the units shown on the display. 
For mass flow meters, there are five columns of data representing pressure, 
temperature, volumetric flow, mass flow and the selected gas. 
The first column is absolute pressure (normally in psia), the second column is 
temperature (normally in °C), the third column is volumetric flow rate (in the 
units specified at time of order and shown on the display), and the fourth column 
is mass flow (also in the units specified at time of order and shown on the 
display). For instance, if the meter was ordered in units of scfm, the display on 
the meter would read 2.004 scfm and the last two columns of the output below 
would represent volumetric flow and mass flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
Pressure Temp Vol. Flow Mass Flow Gas

FMA-1600A Mass Flow Meter Data Format
Note: On units with the totalizer function the fifth column will be the totalizer 
value, with gas select moving to a sixth column.

Collecting Data:
The RS232/RS485 output updates to the screen many times per second. Very short-
term events can be captured simply by disconnecting (there are two telephone 
symbol icons at the top of the HyperTerminal® screen for disconnecting and 
connecting) immediately after the event in question. The scroll bar can be driven 
up to the event and all of the data associated with the event can be selected, 
copied, and pasted into Microsoft® Excel® or other spreadsheet program as 
described below.
For longer term data, it is useful to capture the data in a text file. With the desired 
data streaming to the screen, select “Capture Text” from the Transfer Menu. 
Type in the path and file name you wish to use. Push the start button. When the 
data collection period is complete, simply select “Capture Text” from the Transfer 
Menu and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but the 
default is usually acceptable. Click on “Next” again.  In the third dialog box, make 
sure the column data format is set to “General”, and click “Finish”. This separates 
the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or 
manipulated as desired.      For extended term data capture see page 31.
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard 
streaming mode information is useful for short term events, however, when 
capturing data for an extended period of time, the amount of data and thus the 
file size can become too large very quickly. Without any special programming 
skills, you can use HyperTerminal® and a text editing program such as Microsoft® 
Word® to capture text at defined intervals.
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using 
MS Word, you can tell how many lines you have by the line count at the bottom 
of the screen. The number of lines will correspond to the total number of times 
the flow device will be polled, and thus the total number of lines of data it will 
produce.
For example: A

 A
 A
 A
 A
 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select save. 
In the save dialog box, enter a path and file name as desired and in the “Save as 
Type” box, select the plain text (.txt) option. It is important that it be saved as a 
generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select 
CR Only. Everything else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.
9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you 
type A<Enter>, the meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
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14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell 
the program how often to read a line from the script file you’ve created. 1000 
milliseconds is one second, so if you want a line of data every 30 seconds, you 
would enter 30000 into the box. If you want a line every 5 minutes, you would 
enter 300000 into the box.
15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time 
with the line delay you specified and the flow device will respond by sending one 
line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual under 
“Collecting Data”. You will be simultaneously sending it a script file and capturing 
the output to a separate file for analysis.

Operating Principle

All FMA-1600A Gas Flow Meters and FMA-2600A Gas Flow Controllers are based 
on the accurate measurement of volumetric flow. The volumetric flow rate is 
determined by creating a pressure drop across a unique internal restriction, known 
as a Laminar Flow Element (LFE), and measuring differential pressure across it. 
The restriction is designed so that the gas molecules are forced to move in parallel 
paths along the entire length of the passage; hence laminar (streamline) flow 
is established for the entire range of operation of the device. Unlike other flow 
measuring devices, in laminar flow meters the relationship between pressure drop 
and flow is linear. 

STANDARD GAS DATA TABLES: Those of you who have older Omega products 
may notice small discrepancies between the gas property tables of your old and 
new units. Omega has incorporated the latest data sets from NIST (including 
their REFPROP 9 data where available) in our products’ built-in gas property 
models. Be aware that the calibrators that you may be using may be checking 
against older data sets such as the widely distributed Air Liquide data. This may 
generate apparent calibration discrepancies of up to 0.6% of reading on well 
behaved gases and as much as 3% of reading on some gases such as propane and 
butane, unless the standard was directly calibrated on the gas in question. 
As the older standards are phased out, this difference in readings will cease 
to be a problem. If you see a difference between the Omega meter and your 
in-house standard, in addition to calling Omega, call the manufacturer of your 
standard for clarification as to which data set they used in their calibration. This 
comparison will in all likelihood resolve the problem.
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Supported Units: This device supports many different units. You may select the desired units (see 
page 28). Note that only units appropriate to this device are available for selection.

Pressure Units
Absolute Gauge Differential Notes

PaA PaG PaD pascal
hPaA hPaG hPaD hectopascal
kPaA kPaG kPaD kilopascal
MPaA MPaG MPaD megapascal
mbarA mbarG mbarD millibar
barA barG barD bar

g/cm2A g/cm2G g/cm2D gram force per square centimeter
kg/cmA kg/cmG kg/cmD kilogram force per square centimeter

PSIA PSIG PSID pound force per square inch
PSFA PSFG PSFD pound force per square foot

mTorrA mTorrG mTorrD millitorr
torrA torrG torrD torr

mmHgA mmHgG mmHgD millimeter of mercury at 0 C
inHgA inHgG inHgD inch of mercury at 0 C

mmH2OA mmH2OG mmH2OD millimeter of water at 4 C (NIST conventional)
mmH2OA mmH2OG mmH2OD millimeter of water at 60 C
cmH2OA cmH2OG cmH2OD centimeter of water at 4 C (NIST conventional)
cmH2OA cmH2OG cmH2OD centimeter of water at 60 C
inH2OA inH2OG inH2OD inch of water at 4 C (NIST conventional)
inH2OA inH2OG inH2OD inch of water at 60 C

atm atmosphere
m asl meter above sea level (only in /ALT builds)
ft asl foot above sea level (only in /ALT builds)

V volt; no conversions are performed to or from other units
count count count setpoint count, 0 – 64000

% % % percent of full scale

Flow Units
Volumetric Standard Normal Notes

uL/m SuL/m NuL/m microliter per minute
mL/s SmL/s NmL/s milliliter per second

mL/m SmL/m NmL/m milliliter per minute
mL/h Sml/h NmL/h milliliter per hour

L/s SL/s NL/s liter per second
LPM SLPM NLPM liter per minute
L/h SL/h NL/h liter per hour

US GPM US gallon per minute
US GPH US gallon per hour

CCS SCCS NCCS cubic centimeter per second
CCM SCCM NCCM cubic centimeter per minute

cm3/h Scm3/h Ncm3/h cubic centimeter per hour
m3/m Sm3/m Nm3/m cubic meter per minute
m3/h Sm3/h Nm3/h cubic meter per hour
m3/d Sm3/d Nm3/d cubic meter per day
in3/m Sin3/m cubic inch per minute
CFM SCFM cubic foot per minute
CFH SCFH cubic foot per hour

kSCFM 1000 cubic feet per minute
count count count setpoint count, 0 – 64000

% % % percent of full scale
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True Mass Flow Units
Label Notes
mg/s milligram per second

mg/m milligram per minute
g/s gram per second

g/m gram per minute
g/h gram per hour

kg/m kilogram per minute
kg/h kilogram per hour
oz/s ounce per second

oz/m ounce per minute
lb/m pound per minute
lb/h pound per hour

These can be used for mass flow on gas devices. These can also be used for volumetric flow on liquid 
devices calibrated in one of these units (liquid density is not yet supported).

Totalizer Units
Volumetric Standard Normal Notes

uL SuL NuL microliter
mL SmL NmL milliliter
L SL NL liter

US GAL US gallon
cm3 Scm3 Ncm3 cubic centimeter
m3 Sm3 Nm3 cubic meter
in3 Sin3 cubic inch
ft3 Sft3 cubic foot

kSft3 1000 cubic feet

uP micropoise, a measure of viscosity; no conversions are performed to or from 
other units

Total Mass Units
Label Notes

mg milligram
g gram

kg kilogram
oz ounce
lb pound

These can be used for totalized mass on gas devices. These can also be used for totalized 
volume on liquid devices calibrated in one of these units (liquid density is not yet supported).

Temperature Units
Label Notes

°C degree Celsius
°F degree Farenheit
K Kelvin
°R degree Rankine

Time Units
Label Notes
h:m:s Displayed value is hours:minutes:seconds

ms millisecond
s second

m minute
hour hour
day day
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TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. Please reference the technical 
specifications (pages 51-61) to assure you have the proper power for your model.

Flow reading is approximately fixed either near zero or near full scale 
regardless of actual line flow.
Differential pressure sensor may be damaged. Avoid installations that can 
subject sensor to pressure drops in excess of 10 psid. A common cause of this 
problem is instantaneous application of high-pressure gas as from a snap acting 
solenoid valve upstream of the meter. If you suspect that your pressure sensor 
is damaged please discontinue use of the meter and contact Omega.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and 
message MOV, VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (MOV = mass 
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) when a measured parameter exceeds the range of the 
sensors in the device. When any item flashes on the display, neither the flashing 
parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. If the unit does not return to normal contact Omega.

Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is flow, 
that flow is accepted as zero flow. When an actual zero flow condition exists, 
the meter will read a negative flow. Simply re-tare at the confirmed zero flow 
condition. Also note that while the meter is intended for positive flow, it will 
read negative flow with reasonable accuracy, but not to the full scale flow rate 
(it is not calibrated for bi-directional flow) and no damage will result.

Meter does not agree with another meter I have in line.
Volumetric meters are affected by pressure drops. Volumetric flow meters 
should not be compared to mass flow meters. Mass flow meters can be 
compared against one another provided there are no leaks between the two 
meters and they are set to the same standard temperature and pressure. Both 
meters must also be calibrated (or set) for the gas being measured. FMA-1600A 
mass flow meters are normally set to Standard Temperature and Pressure 
conditions of 25° C and 14.696 psia. Note: it is possible to special order meters 
with a customer specified set of standard conditions. The calibration sheet 
provided with each meter lists its standard conditions. 
When performing this comparison it is best to use the smallest transition 
possible between the two devices. Using small transitions will minimize lag and 
dead volume.
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Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such as from a 
diaphragm pump, etc. Also, inspect the inside of the upstream connection for debris 
such a PTFE tape shreds. 
Note: FMA-1600A meters feature a programmable geometric running average (GRA) 
that can aid in allowing a rapidly fluctuating flow to be read (see “Pressure Averaging” 
and “Flow Averaging” page 22).

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter, 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.

RS232 / RS485 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the 
port on the computer to which the meter is connected is active. Confirm that 
the port settings are correct per the RS232 instructions in this manual (Check 
the RS232 / RS485 communications select screen for current meter readings). 
Close Hyperterminal® and reopen it. Reboot your PC. See pages 10, 11 and 26 
for more information on RS232 / RS485 signals and communications.

Slower response than specified.
FMA-1600A Meters feature a programmable Geometric Running Average 
(GRA). Depending on the full scale range of the meter, it may have the GRA 
set to enhance the stability/readability of the display, which would result in 
slower perceived response time. Please see “Pressure Averaging” and “Flow 
Averaging” on page 22.

Jumps to zero at low flow.
FMA-1600A Meters feature a programmable zero deadband. The factory setting 
is usually 0.5% of full scale. This can be adjusted between NONE and 6.3% of 
full scale. See page 22.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 32.
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Maintenance and Recalibration

General: FMA-1600A Flow Meters require minimal maintenance. They have no 
moving parts. The single most important thing that affects the life and accuracy 
of these devices is the quality of the gas being measured. The meter is designed 
to measure CLEAN, DRY, NON-CORROSIVE gases.

Moisture, oil and other contaminants can affect the laminar flow elements. 
We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.
20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

Recalibration: The recommended period for recalibration is once every year. 
A label located on the back of the meter lists the most recent calibration date. 
The meter should be returned to the factory for recalibration within one year 
from the listed date. Before calling to schedule a recalibration, please note the 
serial number on the back of the meter. The Serial Number, Model Number, and 
Date of Manufacture are also available on the Model Info display (page 25).

Cleaning: FMA-1600A Flow Meters require no periodic cleaning. If necessary, 
the outside of the meter can be cleaned with a soft dry cloth. Avoid excess 
moisture or solvents.

For repairs, recalibrations, or recycling of this product, contact Omega.
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Option: Totalizing Mode
Meters and Controllers can be purchased with the Totalizing Mode option. This 
option adds an additional mode screen that displays the total flow (normally in 
the units of the main flow screen) that has passed through the device since the 
last time the totalizer was cleared. 

The Totalizing Mode screen is accessed by 
pushing the TOTAL button on the MAIN display. 
TOTAL/TIMER: Pushing the TOTAL/TIMER 
button will cycle the large numbers on the 
display between total mass and time elapsed.
Rollover – The customer can also specify at the 
time of order what the totalizer is to do when 
the maximum count is reached. The following 
options may be specified:
No Rollover – When the counter reaches the 
maximum count it stops counting until the 
counter is cleared.

Rollover – When the counter reaches the maximum count it automatically rolls 
over to zero and continues counting until the counter is cleared.
Rollover with Notification – When the counter reaches the maximum count 
it automatically rolls over to zero, displays an overflow error, and continues 
counting until the counter is cleared.

TOTAL MASS: The counter can have as many as seven digits. At the time of order, 
the customer must specify the range. This directly affects the maximum count. For 
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specified 
with a 1 liter range, the maximum count would be 9999999 liters.

ELAPSED TIME: The small numbers below the mass total show the elapsed time 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS232 or RS485 clear is executed or on loss of power. Press 
ELAPSED TIME to show this as the primary display.

RESET – The counter can be reset to zero at any time by pushing the RESET 
button. To clear the counter via RS232 or RS485, establish serial communication 
with the meter or controller as described in the RS232 or RS485 section of the 
manual.  To reset the counter, enter the following commands:

In Polling (addressable) Mode:  Address$$T <Enter>  (e.g. B$$T <Enter>)

MENU

SCCM
+0.0

TOTAL/ 
TIMER

BACK RESET

0000:00:00
SCCM

00000.00
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Omega Portable Meters and Gauges
Omega Rechargeable Flow Meters and Pressure Gauges use a Li-Ion 3.7V cell located in the top 
section of the device. The Li-Ion cell must not be removed.
Normal battery life of a fully-charged cell is 18 hours with a monochrome display or  
5 hours with a TFT color display, when the backlight is set to 10. Dimming the backlight 
will increase battery life.
The battery can be charged through either the micro-USB port or the mini-DIN connector. 
When the device is connected to external power it will function normally while the battery 
is charging. Note: If the battery has no charge, a charge time of one minute will be required 
before the unit can be turned on. Charge rates will be fastest through the micro-USB port 
using the included power supply or equivalent. The device will charge fastest when it is 
turned off. 
Recharge Time: 3.5 hours with 2A USB supply. The micro-USB port is for charging purposes only.
The green/red indicator LED on top of the device will light up green to indicate that the 
unit is charging. The green LED will turn off when the battery is charged and the power 
switch is turned to “I” for ON. 
The indicator LED flashes red when the device has about 1 hour of battery life remaining. The 
LED will flash red at a faster rate when the device has about 15 minutes of battery life remaining.  
It is highly recommended that the device be charged immediately. When the battery charge runs 
out, the display contrast will turn to 0 and device performance is no longer guaranteed.

Output signals from the meter are passed through the mini-DIN connector on top 
of the device. Rechargeable battery units do not support 0-10V analog output.  
Receiver resistance must be below 250Ω.

Turn the power switch on top of the device to “O” for OFF when it is not in use.
Warning: If the device is left ON until the battery can no longer power it, the 
charge indicator will fall out of sync with the actual charge. The device can be 
re-synced by fully charging the battery once.

A Battery Charge Indicator appears below Tare on the display:

CAUTION! Do not operate or store the device outside of the -10° 
to +50°C temperature range. If internal sensors detect that the 
temperature is outside of this range, the display contrast will turn to 0 
and the meter’s performance is no longer guaranteed. 

The safe charging temperature range is 0° to +45°C. If internal sensors detect 
temperatures outside of this range, the battery will not charge.

#C
+21.50

+0.000
CCM MENU

TARE VPSIA
+13.60

+0.000
SCCM

95 – 100%

80 – 95%

50 – 80%

20 – 50%

5 – 20%

0 – 5%

TOP VIEW OF DEVICE

Green = Charging
Flashing Red = Low Battery

+5 Vdc
Charge Only

1 2

3 4 5

6 7 8 I  
 O

On / Off 
I / O
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Pressure Menu for Portable Meters 
Omega portable meters are programmed with additional pressure read options. 
Pressing the pressure button once (upper left) will move the pressure reading 
to the main display. Pressing the button a second time will open a menu of 
pressure read options. Scroll UP or Down and press Select to make a change.

When the pressure button is already using the 
device engineering units, the bottom menu 
option displays as “Set device eng units”.
When the pressure button is using something 
different than device engineering units (e.g., 
bar instead of PSI), the bottom menu option 
displays as “Show device units”.
The serial data line changes only when device 
engineering units are changed, and the 
instrument will prompt you to accept these 
changes to the serial line.

TARE P w/BARO: The stream absolute pressure sensor can be tared to the 
barometric pressure sensor. In this case, the absolute pressure is offset by the 
differential between the two readings. TARE P w/BARO can be accessed from the 
MISC2 display.

#C
+21.50

+0.000
CCM

MENU/
TOTAL

TARE VPSIA
+13.60

+0.000
SCCM

+13.60
Abs Press

DOWN

CANCEL SELECT

>Show abs pressure
  Show gauge pressure
  Show baro pressure
  Set button eng units
  Set device eng units

UP

PSIA
Ait

DOWN

CANCEL SELECT

>Show abs pressure
  Show gauge pressure
  Show baro pressure
  Set button eng units
  Show device units

UP

DIAG
TEST

BACK
TARE P
w/BARO MAIN

STP/
NTP

ROTATE 
DISP VENT TO ATMOSPHERE

WITH NO FLOW BEFORE 
PRESSING SET.

Current absolute  
sensor offset:

+0.000 barG
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Accessory: FMA1600-MDB Multi-Drop Box

The FMA1600-MDB Multi-Drop Box makes it convenient 
to wire multiple flow and/or pressure devices to a single 
RS232 or RS485 port. Now available with a USB interface!

The Multi-Drop Box has nine 8 pin mini-DIN ports available. 
The ports are to be used with a standard double ended 8 pin 

mini-DIN (DC-62) style cable going from the box to each flow or pressure device. 

A single DB9 D-SUB type connector (COM PORT) connects, using the included 
cable, to the serial connector on a PC or laptop. 

All of the flow and/or pressure devices are powered via a terminal block on the 
front of the box. 

If more than nine devices will be required, additional Multi-Drop Boxes can be 
daisy chained together with a double ended 8 pin mini-DIN cable plugged into 
any receptacle on both boxes.

FMA1600-MDB Power Supply for Large Valve Controllers: The PS24VHC (Power 
Supply 24Vdc High Current) is a 6.5Amp 24Vdc power supply designed for 
running multiple large controllers on a FMA1600-MDB. 

The 6.5Amp power supply can run as many as 8 large valve controllers, which 
makes it ideal for the FMA1600-MDB and multiple large valve (or small valve / 
large valve combination) controllers on a FMA1600-MDB.

BB-9 Multi-Drop 
BoxØ .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

3.46

6.75 1.55

5.06

FMA1600-MDB Multi-Drop Box

Ø .156 Thru 4 Places

1.75

Ø .340 Thru 2 PL

Ø .175 Thru 2 PL

3.46

6.75 1.55

5.06

6.75

7.56
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Accessories

Part Number Description

FMA1600-C1 8 Pin Male Mini-DIN connector cable, single ended, 
6 foot length

FMA1600-C2 8 Pin Male Mini-DIN connector cable, double ended, 
6 foot length

FMA1600-C3 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot 
length

FMA1600-PSU Universal 100-240 VAC to 24 Volt DC Power Supply 
Adapter

FMA1600-CRA 8 Pin Male Right Angle Mini-Din Cable, single ended, 
6 foot length

FMA1600-C1-25FT 8 Pin Male Mini-DIN connector cable, single ended, 
25 foot length

FMA1600-C2-25FT 8 Pin Male Mini-DIN connector cable, double ended, 
25 foot length

FMA1600-MDB Multi-Drop Box
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Technical Data for FMA-1600A Mass Flow Meters
0 to 0.5 sccm Full Scale through 0 to 5000 slpm Full Scale

Standard Operating Specifications (Contact Omega for available options)
Performance FMA-1600A Mass Flow Meter

Accuracy at calibration conditions 
after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration conditions 
after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Accuracy for Bidirectional Meters
at calibration conditions after tare ± (0.8% of reading + 0.2% of total span from positive full scale to negative full scale)

Repeatability ± 0.2% Full Scale

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Maximum Measurable Flow Rate 128% Full Scale

Typical Response Time 10 ms (Adjustable) 

Warm-up Time < 1 Second

Communications / Power FMA-1600A Mass Flow Meter
Monochrome LCD Display with 

integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Output Signal1 Options RS232 Serial / RS485 Serial  

Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog Output 

Signal2 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15) 
Supply Voltage 7 to 30 Vdc (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp (+ output current on 4-20 mA)

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature

Operating Conditions FMA-1600A Mass Flow Meter
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius

Humidity Range (Non–Condensing) 0 to 100%
Maximum Pressure 145 psig

Mounting Attitude Sensitivity None

Ingress Protection IP40

Wetted Materials
303 & 302 Stainless Steel, FKM Heat Cured Silicone Rubber, Glass Reinforced 
Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Silicon, Glass.
If your application demands a different material, please contact Omega.

Full Scale Flow Mass 
Meter

Pressure Drop at FS Flow  
(psid) venting to atmosphere1

Mechanical 
Dimensions Process Connections2

0.5 sccm to 1 sccm 1.0
3.9”H x 2.4”W x 1.1”D M-5 (10-32) Female Thread 

2 sccm to 50 sccm 1.0
100 sccm to 20 slpm 1.0 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female

50 slpm 2.0
4.4”H x 4.0”W x 1.6”D 1/4”  NPT Female

100 slpm 2.5
250 slpm 2.1 5.0”H x 4.0”W x 1.6”D 1/2”  NPT Female
500 slpm 4.0

5.0”H x 4.0”W x 1.6”D
3/4” NPT Female 

(A 1-1/4” NPT Female optional 
process connection is available 

for 2000 slpm meters.)

1000 slpm 6.0
1500 slpm 9.0
2000 slpm 5.0 5.3”H x 5.2”W x 2.9”D
3000 slpm 7.1 5.3”H x 5.2”W x 2.9”D 1-1/4” NPT Female

4000 slpm 4.4 7.6”H x 5.2”W x 2.9”D
2” NPT Female

5000 slpm 3.4 6.3”H x 5.2”W x 3.9”D

1. Lower Pressure Drops Available, please see our FMA-LP1600A mass flow meters.t
2. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 
connections upon request. 

Range Specific Specifications



52

2.375in
60.33mm

3.897in
98.98mm

DATE

M-0.5SCCM-D-MSPEC
REV.
1

1/4/2016

[8.53mm]
.336in

.525in
[13.34mm]

1.050in
26.67mm

.925in

3.175mm

23.495mm

2.225in
56.52mm

.125in
.150in

3.81mm

2X 8-32 UNC   .175in[4.45mm]

.525in
[13.34mm]

.336in
[8.53mm]

Both Sides
M5X0.8  (10-32 UNF)

1M-20SLPM-D-MSPEC

1/4/2016
DATE

REV.

.525in
13.34mm

.350in
8.89mm

13.34mm
.525in

.350in
8.89mm

Both Sides
1/8  NPT

4.067in
103.30mm

2.375in
60.33mm

1.050in
26.67mm

23.50mm
.925in

.150in
3.81mm

2.225in
56.52mm

.125in
3.18mm

2X 8-32 UNC   .350in 8.89mm

FMA-1600A
0 – 0.5 sccm
0 – 1 sccm
0 – 2 sccm
0 – 5 sccm
0 – 10 sccm
0 – 20 sccm
0 – 50 sccm

FMA-1600A
0 – 100 sccm
0 – 200 sccm
0 – 500 sccm
0 – 1 slpm
0 – 2 slpm
0 – 5 slpm
0 – 10 slpm
0 – 20 slpm

0.5 sccm to 50 sccm approximate shipping weight: 0.8 lb

100 sccm to 20 slpm approximate shipping weight: 1.0 lb
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4.000in
101.60mm

1.600in
40.64mm

20.32mm
.800in

.800in
20.32mm

Both Sides
1/2  NPT

36.20mm
1.425in

4.45mm
19.05mm

.750in
.175in

3.250in
82.55mm

4X 8-32 UNC    .375in[9.53mm]

.800in
20.32mm

.800in
20.32mm

4.967in
126.16mm

1M-250SLPM-D-MSPEC

1/4/2016
DATE

REV.

250 slpm approximate shipping weight: 3.2 lb.

50 slpm to 100 slpm approximate shipping weight: 2.4 lb.

1.600in
40.64mm

110.92mm
4.367in

4.000in
101.60mm

1M-50SLPM-D-MSPEC

1/4/2016
DATE

REV.

12.70mm
.500in

.800in
20.32mm

12.70mm
.500in

.800in
20.32mm Both sides

1/4  NPT

19.05mm
.750in

3.250in
82.55mm

4.45mm
.175in

1.425in
36.20mm

4X 8-32 UNC   .375in[9.53mm]

FMA-1600A
0 – 50 slpm
0 – 100 slpm

FMA-1600A
0 – 250 slpm
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4.45mm
.175in

36.20mm

19.05mm
.750in

1.425in

3.250in
82.55mm

4X 8-32 UNC    .375in[9.53mm]

20.32mm
.800in

.800in
20.32mm

 Both sides
3/4 NPT

1.600in
40.64mm

1/4/2016
DATE

1M-500SLPM-D-MSPEC
REV.

.800in
20.320mm

.800in
20.320mm

126.16mm
4.967in

101.60mm
4.000in

500 slpm to 1500 slpm approximate shipping weight: 3.5 lb

2000 slpm approximate shipping weight: 4.5 lb

2.900in
73.66mm

1.450in
36.83mm

1.120in
28.45mm

Both Sides
3/4  NPT

28.45mm
1.120in

1.450in
36.83mm5.200in

132.08mm

5.287in
134.29mm

1M-2000SLPM-D-MSPEC

01/04/2016
DATE

REV.

X 8-32 UNC    .330in[8.382mm]4
97.79mm
3.850in

1.350in
34.29mm

.200in
5.08mm

68.58mm
2.700in

FMA-1600A
0 – 500 slpm
0 – 1000 slpm
0 – 1500 slpm

FMA-1600A
0 – 2000 slpm
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1
REV.

DATE

01/4/2016

M-4000SLPM-D-MSPEC

 NPT2
Both Sides

36.83mm
1.450in

58.29mm
2.295in

2.900in
73.66mm

5.200in
132.08mm

192.58mm
7.582in

2.295in
58.29mm

1.450in
36.83mm

3000 slpm approximate shipping weight: 4.5 lb

4000 slpm approximate shipping weight: 12.2 lb

1/4/2016
DATE

1M-3000SLPM-D-MSPEC
REV.

5.08mm
.200in

.330in[8.382mm]   8-32 UNCX 4

1.350in
34.29mm

3.850in
97.79mm

68.58mm
2.700in

2.900in
73.66mm

36.83mm
1.450in

.960in
24.38mm

Both Sides
1-1/4  NPT"

24.38mm
.960in

1.450in
36.83mm5.200in

132.08mm

5.287in
134.29mm

FMA-1600A
0 – 3000 slpm

FMA-1600A
0 – 4000 slpm
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










 



 



 

  




 


 

  



 

FMA-1600A
0 – 5000 slpm

5000 slpm approximate shipping weight:14 lb
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Technical Data for FMA-LP1600A Low Pressure Drop Mass Flow Meters
0 to 0.5 sccm Full Scale through 0 to 500 slpm Full Scale

Standard Operating Specifications (Contact Omega for available options.)
Performance FMA-LP1600A Mass Flow Meter

Accuracy at calibration conditions 
after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration conditions 
after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Accuracy for Bidirectional Meters
at calibration conditions after tare ± (0.8% of reading + 0.2% of total span from positive full scale to negative full scale)

Repeatability ± 0.2% Full Scale

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Maximum Measurable Flow Rate 128% Full Scale

Typical Response Time 10 ms (Adjustable) 

Warm-up Time < 1 Second

Communications / Power FMA-LP1600A  Mass Flow Meter
Monochrome LCD Display with 

integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Output Signal1 Options RS232 Serial / RS485 Serial 

Analog Output Signal2 Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA   
Optional Secondary Analog Output 

Signal2
0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA  

Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15) 
Supply Voltage 7 to 30 Vdc (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.040 Amp (+ output current on 4-20 mA)

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature 
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass 

Flow, Volumetric Flow, Pressure or Temperature 

Operating Conditions FMA-LP1600A  Mass Flow Meter
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius

Humidity Range (Non–Condensing) 0 to 100%
Maximum Pressure 50 psig1         Higher line pressures available, please contact Omega.

Mounting Attitude Sensitivity None

Ingress Protection IP40

Wetted Materials
303 & 302 Stainless Steel, FKM Heat Cured Silicone Rubber, Glass Reinforced 
Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Silicon, Glass.
If your application demands a different material, please contact Omega.

1. Do Not subject a FMA-LP1600A Differential Pressure sensor to upstream-downstream pressure 
differentials exceeding 15 PSID.

Full Scale Flow 
Mass Meter

Pressure Drop at FS Flow 
(psid)venting to atmosphere Mechanical Dimensions Process Connections1

0.5 sccm to 2 sccm 0.06
3.9”H x 2.4”W x 1.1”D

M-5 (10-32) Female Thread
5 sccm to 20 sccm 0.07

50 sccm 0.07

4.1”H x 2.4”W x 1.1”D 1/8” NPT Female100 sccm to 200 sccm 0.06
500 sccm 0.07

1 slpm to 5 slpm 0.07
10 slpm 0.08 4.3”H x 2.7”W x 1.1”D 1/4”  NPT Female20 slpm 0.25 4.4”H x 4.0”W x 1.6”D
40 slpm 0.12 5.0”H x 4.0”W x 1.6”D 1/2”  NPT Female
50 slpm 0.14

5.0”H x 4.0”W x 1.6”D 3/4” NPT Female100 slpm 0.24
250 slpm 0.60
500 slpm 0.39 5.3”H x 5.2”W x 2.9”D 3/4” NPT Female

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 
connections upon request.

Range Specific Specifications
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MW-5SLPM-D-MSPEC

1/5/2016
DATE

1
REV.

1.050in
26.67mm

103.30mm
4.067in

2.375in
60.33mm

.525in
13.34mm

.350in
8.89mm

13.34mm
.525in

.350in
8.89mm

Both Sides
1/8  NPT

56.52mm
2.225in

.150in
3.81mm 3.18mm

.125in

.925in
23.50mm

2X 8-32 UNC   .350in 8.89mm

1

DATE

MW-20SCCM-D-MSPEC
REV.

12/10/2015

2.375in
60.33mm

3.897in
98.98mm

1.050in
26.67mm

8.534mm
.336in

.525in
13.335mm

.925in

56.52mm
2.225in

23.495mm

3.175mm
.125in

.150in
3.81mm

2X 8-32 UNC   .175in[4.45mm]

13.335mm
.525in

.336in
8.534mm

Both Sides
M5X0.8  (10-32 UNF)

0.5 sccm to 20 sccm approximate shipping weight: 0.8lb

50 sccm to 5 slpm approximate shipping weight: 1.0lb

FMA-LP1600A
0 – 0.5 sccm
0 – 1 sccm
0 – 2 sccm
0 – 5 sccm
0 – 10 sccm
0 – 20 sccm

FMA-LP1600A
0 – 50 sccm 
0 – 100 sccm
0 – 200 sccm
0 – 500 sccm
0 – 1 slpm
0 – 2 slpm
0 – 5 slpm
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9.09mm

Both Sides
1/4 NPT

.358in

13.34mm
.525in

66.68mm
2.625in

106.86mm
4.207in

1.050in
26.67mm

1MW-10SLPM-D-MSPEC

12/12/2015
DATE

REV.
 .350in

6.99mm
.275in

.125in
3.18mm

.925in
23.50mm

8.89mm2X 8-32 UNC  

59.69mm
2.350in

13.34mm
.525in

9.09mm
.358in

 20 slpm approximate shipping weight: 2.4 lb.

10 slpm approximate shipping weight: 1.4 lb.

12.70mm
.500in

.800in
20.32mm

1.600in
40.64mm

.175in

19.05mm
.750in 4.45mm

3.250in
82.55mm

1.425in
36.20mm

4X 8-32 UNC   .375in[9.53mm]

12.70mm
.500in

.800in
20.32mm

Both sides
1/4  NPT

4.367in
110.92mm

4.000in
101.60mm

MW-20SLPM-D-MSPEC

12/12/2015
DATE

1
REV.

FMA-LP1600A
0 – 20 slpm

FMA-LP1600A
0 – 10 slpm
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40 slpm to 250 slpm approximate shipping weight: 3.5 lb.

1.600in
40.64mm

.800in
20.32mm

.800in
20.32mm

4.967in
126.16mm

101.60mm
4.0000in

1MW-40SLPM-D-MSPEC

12/12/2015
DATE

REV.

20.32mm
.800in

.800in
20.32mm

Both Sides
1/2  NPT

4.45mm

1.425in
36.20mm

19.05mm
.750in

.175in

3.250in
82.55mm

4X 8-32 UNC    .375in[9.53mm]

500 slpm approximate shipping weight: 4.5lb

1.250in
31.750mm 1.250in

31.750mm

2.600in  REF
66.040mm

1.450in  REF
36.830mm

63.500mm
2.500in

2.500in
63.500mm

4X 8-32 UNC    .330in[8.382mm]

5.200in
132.080mm

5.287in
134.290mm

36.830mm
1.450in

1.120in
28.448mm

Both Sides
3/4  NPT

DATE

2MW-500SLPM-D-MSPEC

12/12/2015
REV.

2.900in
73.660mm

28.448mm
1.120in

1.450in
36.830mm

FMA-LP1600A
0 – 40 slpm
0 – 50 slpm
0 – 100 slpm
0 – 250 slpm

FMA-LP1600A
0 – 500 slpm
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Technical Data for FMA-1600A-LSS Mass Flow Meters

FMA-1600A-LSS instruments are built for use with aggressive gases. For the 
most part, these instruments maintain the specifications of equivalently ranged 
FMA-1600A devices. 

Standard Compatible Gas List for FMA-1600A-LSS Meters
0 Air Air
1 Argon     Ar
2 Methane   CH4
3 Carbon Monoxide  CO
4 Carbon Dioxide   CO2
5 Ethane  C2H6
6 Hydrogen  H2
7 Helium   He
8 Nitrogen  N2
9 Nitrous Oxide N2O

10 Neon  Ne
11 Oxygen  O2
12 Propane  C3H8
13 normal-Butane  n-C4H10
14 Acetylene  C2H2
15 Ethylene  C2H4
16 iso-Butane  i-C4H10
17 Krypton  Kr
18 Xenon  Xe
19 Sulfur Hexafluoride SF6
20 75%Ar / 25% CO2 C-25
21 90% Ar / 10% CO2 C-10
22 92% Ar / 8% CO2 C-8

23 98% Ar / 2% CO2 C-2
24 75% CO2 / 25% Ar C-75
25 75% Ar / 25% He A-75
26 75% He / 25% Ar A-25

27
90% He / 7.5% Ar / 

2.5% CO2
 Helistar® A1025

A1025

28
90% Ar / 8% CO2 / 

2% O2
Stargon® CS

Star29

29 95% Ar / 5% CH4 P-5
30 Nitric Oxide NO
31 Nitrogen Triflouride NF3
32 Ammonia NH3
33 Chlorine Gas Cl2
34 Hydrogen Sulfide H2S
35 Sulfur Dioxide SO2
36 Propylene C3H6
In addition, the following gases are 
available upon request: 
Nitrogen Dioxide to 0.5% 
in an inert carrier NO2

Refrigerant gases to 100%

If your application requires another gas or gas mixture, please contact 
Omega. We will do our best to accommodate your request.

Please refer to the Technical Data for the equivalently ranged FMA-1600A 
instrument for all operating specifications except:

Operating Range 1% to 100% Full Scale
Turndown Ratio 100 : 1

Wetted Materials 316LSS, Perfluoroelastomer standard; FKM, EPDM, 
Buna, Neoprene as needed for some gases.

The dimensions of FMA-1600A-LSS instruments may vary from their standard 
FMA-1600A counterparts. Dimensional drawings for MS instruments are shown on 
pages 57-60.



62

1.050in
26.67mm

3.81mm
.150in

 .35in[8.89mm]2X 8-32 UNC  

.925in

56.52mm

23.50mm

2.225in

.125in
3.18mm

.525in
13.34mm

.350in
8.89mm

13.34mm
.525in

.350in
8.89mm

1/8 NPT
Both Sides 2.375in

60.33mm

4.567in
116mm

DATE

12/11/2015

MS-20SLPM-D-MSPEC
REV.
1100 sccm to 20 slpm approximate shipping weight: 1.0 lb

0.5 sccm to 50 sccm approximate shipping weight: 0.8lb

8.53mm

 Both Sdes
M5X0.8  (10-32 UNF)

.336in

.525in
13.34mm

3.18mm

23.50mm

.125in

56.52mm
2.225in

.925in

.150in
3.81mm

2X 8-32 UNC   .175in[4.45mm]

1.050in
26.67mm

60.33mm
2.375in

4.397in
111.68mm

8.53mm
.336in

.525in
13.34mm

DATE

MS-0.5SCCM-D-MSPEC 1

12/10/2015

REV.

FMA-1600A-LSS
0 – 0.5 sccm
0 – 1 sccm
0 – 2 sccm
0 – 5 sccm
0 – 10 sccm
0 – 20 sccm
0 – 50 sccm

FMA-1600A-LSS
0 – 100 sccm
0 – 200 sccm
0 – 500 sccm
0 – 1 slpm
0 – 2 slpm
0 – 5 slpm
0 – 10 slpm
0 – 20 slpm
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DATE

MS-250SLPM-D-MSPEC 1

12/11/2015

REV.

5.667in
143.94mm

4.000in
101.60mm

1.600in
40.64mm

20.32mm
.800in

.800in
20.32mm

Both Sides
1/2  NPT

20.32mm
.800in

.800in
20.32mm

82.55mm
3.250in

.750in
19.05mm

4.45mm
.175in

1.425in
36.20mm

4X 8-32 UNC   .375in[9.53mm]

.800in
20.32mm

.500in
12.70mm

DATE

MS-50SLPM-D-MSPEC 1

1/11/2016

REV.

1.600in
40.64mm

19.05mm
.750in

3.250in
82.55mm

4.45mm
.175in

1.425in
36.20mm

4X8-32 UNC   .375in[9.53mm]

20.32mm
.800in

.500in
12.70mm

Both Sides
1/4  NPT

4.000in
101.60mm

5.067in
128.70mm

250 slpm approximate shipping weight: 3.2 lb.

50 slpm to 100 slpm approximate shipping weight: 2.4 lb.

FMA-1600A-LSS
0 – 50 slpm
0 – 100 slpm

FMA-1600A-LSS
0 – 250 slpm
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1.250in
31.750mm

1.250in
31.750mm

28.448mm
1.120in

1.450in
36.830mm

36.830mm
1.450in

1.120in
28.448mm

Both Sides
3/4  NPT

63.500mm
2.500in

2.500in
63.500mm

4X 8-32 UNC   .330in[8.382mm]

2.900in
73.660mm

5.200in
132.080mm

5.987in
152.070mm

DATE

MS-2000SLPM-D-MSPEC 1

1/8/2016

REV.

1.600in
40.64mm

20.32mm
.800in

.800in
20.32mm

19.05mm
.750in

3.250in
82.55mm

4.45mm
.175in

1.425in
36.20mm

4X8-32 UNC    .375in[9.53mm]

Both Sides
3/4 NPT

20.32mm
.800in

.800in
20.32mm

4.000in
101.60mm

5.667in
143.94mm

DATE

MS-1000SLPM-D-MSPEC 1

1/8/2016

REV.

500 slpm to 1500 slpm approximate shipping weight: 3.5 lb

2000 slpm approximate shipping weight: 4.5 lb

FMA-1600A-LSS
0 – 2000 slpm

FMA-1600A-LSS
0 – 500 slpm
0 – 1000 slpm
0 – 1500 slpm
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2.295in
58.29mm

1.450in
36.83mm

210.36mm
8.282inBoth Sides

 NPT2

36.83mm
1.450in

58.29mm
2.295in

2.900in
73.66mm

5.200in
132.08mm

1/8/2016

1
REV.

DATE

MS-4000SLPM-D-MSPEC

24.38mm
.960in

1.450in
36.83mm

97.79mm
3.850in

.200in
5.08mm

4X 8-32 UNC    .330in[8.38mm]

34.29mm
1.350in

68.58mm
2.700in

2.900in
73.66mm

1.450in
36.83mm

.960in
24.38mm

1-1/4  NPT
 1.484in[37.69mm]   .700in[17.78mm]

5.200in
132.08mm

5.987in
152.07mm

DATE

1MS-3000SLPM-D-MSPEC

1/8/2016
REV.

3000 slpm approximate shipping weight: 4.5 lb

4000 slpm approximate shipping weight: 12.2 lb

FMA-1600A-LSS
0 – 3000 slpm

FMA-1600A-LSS
0 – 4000 slpm
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Eight Pin Mini-DIN Connector Pin-Outs
If your FMA-1600A Instrument was ordered with the standard Eight Pin 

Mini-DIN connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out



 







1 2

3 4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive (or optional 4-20mA Primary Output Signal) Black

2 Static 5.12 Vdc [or optional Secondary Analog Output (4-20mA, 
5Vdc, 10Vdc) or Basic Alarm] Brown

3 Serial RS232RX / RS485(–) Input Signal (receive) Red

4 Meters = Remote Tare (Ground to Tare)
Controllers = Analog Set-Point Input Orange

5 Serial RS232TX  / RS485(+) Output Signal (send) Yellow
6 0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 Power In (as described above) Blue

8 Ground (common for power, digital communications, analog signals 
and alarms) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the 
Mini-DIN connector. The availability of different output signals depends on the options 
ordered. Optional configurations are noted on the unit’s calibration sheet.
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.

DB15

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8  Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 RS232 RX (receive) or RS485 –
14 Ground
15 RS232 TX (send) or RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are 
common grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15 equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

8

15 13 11 9

25
8

1513119

2 5
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Pin Number Function
1 Ground
2 Primary Analog Signal Output

3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS232 Tx (send) / RS485 –
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS232 Rx (receive) / RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 4, 5, 6 and 9 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

DB15A (XFM)

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15A equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.

Male Connector Front View Female Connector Front View

8

15 12 9

25
8

15129

2 53
3

7
7

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15B

Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS232 RX (receive) or RS485 –*
15 RS232 TX (send) or RS485 +*

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory)
* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15B equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15K

The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15B equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.

Pin Number Function
1 N/C
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply Common
6 N/C
7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *
10 N/C
11 Ground
12 Ground
13 RS232 RX (receive) or RS485 – *
14 RS232 TX (send) or RS485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15H

Pin Number Function
1 N/C
2 RS232 RX (receive) or RS485 – *
3 N/C
4 N/C
5 Ground
6 Primary Analog Signal Output
7 Power Supply Common
8 N/C
9 N/C
10 Secondary Analog Signal Output / fixed 5.12Vdc *
11 Power Supply (+Vdc) 
12 Ground
13 N/C

14 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

15 RS232 TX (send) or RS485 + *
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15B equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15O

Pin Number Function
1 Ground
2 N/C
3 N/C
4 Primary Analog Signal Output
5 Power Supply (+Vdc)
6 N/C

7 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)* 

8 N/C
9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS232 RX (receive) or RS485 –*
15 RS232 TX (send) or RS485 +*

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common 
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory)

* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

The following pin-out chart describes the safest and generally compatible arrangement 
when connecting a non-FMA-1600A Series DB15 wire to a DB15O equipped FMA-1600A 
Series. Not all features may be available between brands, but the common denominators are 
featured in our DB15 offerings, along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 
Calibration Label on the device and reference the appropriate pin-out diagram.
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DB15S

Pin Number Function
1 Ground
2 Primary Analog Signal Output 
3 N/C
4 N/C
5 Ground
6 N/C
7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc *
12 RS232 RX (receive) or RS485 – *
13 Power Supply (+Vdc) 
14 RS232 TX (send) or RS485 + *
15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common 
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments – please consult factory).
* Added to allow for full use of features on FMA-1600A devices, may not be present on host wiring.

Male Connector Front View Female Connector Front View
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The following pin-out chart describes the safest and generally compatible arrangement when 
connecting a non-FMA-1600A DB15 wire to a DB15B equipped FMA-1600A. Not all features 
may be available between brands, but the common denominators are featured in our DB15 
offerings, along with some options for customization.

DB15 Pin-Outs
If your instrument was ordered with a DB15 connection, be sure to check the 

Calibration Label on the device and reference the appropriate pin-out diagram.
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WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and 
workmanship for a period of 13 months from date of purchase. OMEGA’s WARRANTY adds 
an additional one (1) month grace period to the normal one (1) year product warranty to 
cover handling and shipping time. This ensures that OMEGA’s customers receive maximum 
coverage on each product. 
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer 
Service Department will issue an Authorized Return (AR) number immediately upon phone 
or written request. Upon examination by OMEGA, if the unit is found to be defective, it 
will be repaired or replaced at no charge. OMEGA’s WARRANTY does not apply to defects 
resulting from any action of the purchaser, including but not limited to mishandling, improper 
interfacing, operation outside of design limits, improper repair, or unauthorized modification. 
This WARRANTY is VOID if the unit shows evidence of having been tampered with or shows 
evidence of having been damaged as a result of excessive corrosion; or current, heat, moisture 
or vibration; improper specification; misapplication; misuse or other operating conditions 
outside of OMEGA’s control. Components in which wear is not warranted, include but are not 
limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However,  
OMEGA neither assumes responsibility for any omissions or errors nor assumes 
liability for any damages that result from the use of its products in accordance 
with information provided by OMEGA, either verbal or written. OMEGA warrants 
only that the parts manufactured by the company will be as specified and free of 
defects. OMEGA MAKES NO OTHER WARRANTIES OR REPRESENTATIONS OF ANY 
KIND WHATSOEVER, EXPRESSED OR IMPLIED, EXCEPT THAT OF TITLE, AND ALL 
IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION 
OF LIABILITY: The remedies of purchaser set forth herein are exclusive, and the 
total liability of OMEGA with respect to this order, whether based on contract, 
warranty, negligence, indemnification, strict liability or otherwise, shall not exceed 
the purchase price of the component upon which liability is based. In no event shall 
OMEGA be liable for consequential, incidental or special damages.
CONDITIONS:  Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) 
as a “Basic Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or 
activity; or (2) in medical applications or used on humans. Should any Product(s) be used in or 
with any nuclear installation or activity, medical application, used on humans, or misused in 
any way, OMEGA assumes no responsibility as set forth in our basic WARRANTY / DISCLAIMER 
language, and, additionally, purchaser will indemnify OMEGA and hold OMEGA harmless from 
any liability or damage whatsoever arising out of the use of the Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department. 
BEFORE RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN 
AUTHORIZED RETURN (AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT 
(IN ORDER TO AVOID PROCESSING DELAYS). The assigned AR number should then be 
marked on the outside of the return package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to 
prevent breakage in transit.  

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible.  
This affords our customers the latest in technology and engineering.
OMEGA is a trademark of OMEGA ENGINEERING, INC.
© Copyright 2018 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without 
the prior written consent of OMEGA ENGINEERING, INC.

FOR WARRANTY RETURNS, please have 
the following information available BEFORE  
contacting OMEGA:
1. Purchase Order number under which  
 the product was PURCHASED,
2.  Model and serial number of the product 

under warranty, and
3.  Repair instructions and/or specific  

problems relative to the product.

FOR NON-WARRANTY REPAIRS, consult 
OMEGA for current repair charges. Have the 
following information available BEFORE  
contacting OMEGA:
1.  Purchase Order number to cover the  

COST of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems  
 relative to the product.



Where Do I Find Everything I Need for  
Process Measurement and Control?  

OMEGA…Of Course!
Shop online at omega.com

TEMPERATURE
MU   Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies 
MU   Wire: Thermocouple, RTD & Thermistor
MU   Calibrators & Ice Point References
MU   Recorders, Controllers & Process Monitors
MU   Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
MU   Transducers & Strain Gages
MU   Load Cells & Pressure Gages
MU   Displacement Transducers
MU   Instrumentation & Accessories

FLOW/LEVEL
MU   Rotameters, Gas Mass Flowmeters & Flow Computers
MU   Air Velocity Indicators
MU   Turbine/Paddlewheel Systems
MU   Totalizers & Batch Controllers

pH/CONDUCTIVITY
MU   pH Electrodes, Testers & Accessories
MU   Benchtop/Laboratory Meters
MU   Controllers, Calibrators, Simulators & Pumps
MU   Industrial pH & Conductivity Equipment

DATA ACQUISITION
MU   Communications-Based Acquisition Systems
MU   Data Logging Systems
MU   Wireless Sensors, Transmitters, & Receivers
MU   Signal Conditioners
MU   Data Acquisition Software

HEATERS
MU   Heating Cable
MU   Cartridge & Strip Heaters
MU   Immersion & Band Heaters
MU   Flexible Heaters
MU   Laboratory Heaters

ENVIRONMENTAL 
MONITORING AND CONTROL
MU   Metering & Control Instrumentation
MU   Refractometers
MU   Pumps & Tubing
MU   Air, Soil & Water Monitors
MU   Industrial Water & Wastewater Treatment
MU   pH, Conductivity & Dissolved Oxygen Instruments

M3704/0118




